
Software Release Notes  

March 11, 2026 

OPS685 Cutting Master 5 for Mac 

Version 1.11.50 Release date: March 11, 2026  

⚫ Function Added. 

1. Added a “Page Length” setting to the [Remote Panel Utility] (FC9000/CE8000/CE7000 
only). 

2. [Data Link Sever] has been made universal. 

⚫ Fixed Problem. 

1. Fixed a problem where, when “Repeat Job” was specified and cutting was in progress, 
the cutting plotter resumed the repeat cutting even if the user stopped the cut operation 
on the main unit (CE8000/CE8000-40+ASF1 only). 

2. Fixed a problem where, even when “Use Document Origin” was specified in the 
“General” tab under “Origin”, the setting was invalidated and cut lines shifted to the 
lower-right when some cut lines were turned OFF in the “Option” tab using either “By 
Color” or “By Layer”. 

3. Fixed a problem where, when “Auto Weld” was turned ON for certain files, shapes that 
were not overlapping were mistakenly deleted. 

4. Fixed a problem where sub-layers could not be recognized when using “By Layer” in 
the “Option” tab. 

5. Fixed a problem where, when closing the cut screen over a LAN connection, press the 
OK button on the message that appears caused the application to freeze and the 
screen could not be closed. 

6. Fixed a problem where, after selecting “By Color” or “By Layer” in the “Option” tab and 
then turning ON “Weed Vorder”, the weeding border (green line) was not displayed in 
the cut preview and was not cut during output. 

7. Fixed a problem where, after selecting “By Color” or “By Layer” in the “Option” tab and 
then turning ON “Weed Border”, reopening the “Option” tab caused the setting to revert 
to “ALL”. 

8. Fixed a problem where, when “Weed Border” was turned ON, shapes that had the 
check removed in the “Color/Layer” list were not hidden in the cut preview. 

9. Fixed a problem where, in the “Data Link Server Settings” screen, opening the right-
click menu displayed English text even when Japanese was selected. 

10. Fixed a problem where, in the “ARMS” tab of the [Remote Panel Utility], the text for 
“Auto Search” and “Sensing Method” was displayed swapped. 

11. Fixed a problem where, when the cutting plotter was set to inch mode, the “2mm 
BELOW” option under  “INITIAL BLADE ANGLE POSITION” in the “Others” tab of the 
[Remote Panel Utility] was not displayed in inches. 

12. Fixed problem where, when multiple PCs were using a cutting plotter over a network, 



none of the PCs were able to send data. 

13. Fixed a problem where, in the “Data Link Server Settings” screen, deleting a 
“Destination Email Address” using the “-” button and then closing and reporting the 
stings screen caused the deleted email address to reappear. 

14. Fixed a problem where, in the “Data Link Server Settings” screen, a test send 
performed with incorrect email notification settings did not display a failure error 
message. 

 
 
Version 1.10.36 Release date: December 26, 2025  

⚫ Function Added. 

3. Added the WLAN setting function for CE8000 series and CE8000-ASF1-30. 

⚫ Fixed Problem. 

1. Fixed a problem where staring another queued job during cutting stopped the cutter 
from working afterward. 

2. Fixed a problem where Matrix Copy settings were not applied to [Job Size] in [General] 
tab, causing the carriage to move incorrectly. 

3. Fixed a problem where maximum values withing the media range could not be entered 
for Matrix Copy [X Copy] and [Y Copy]. 

4. Fixed a problem where enabling [Auto Weld] with certain data caused slow preview 
updates. 

5. Fixed a problem where [Skip pass] did not appear in the [Condition Name] dropdown 
after installing a new version over Ver.1.1.20 or earlier. 

 
Version 1.9.95 Release date: December 3, 2025  

⚫ Function Added. 

1. Supported Adobe Illustrator 2026. 
 
Version 1.9.92 Release date: October 31, 2025  

⚫ Fixed problem 

1. Fixed a problem in which the cut screen would freeze when performing a cut with 
‘Repeat Job’. 

2. Fixed a problem in which a timeout error occurred after reading the barcode on the 
second page during continuous operation with CE8000-40+ASF1 connected via wired 
LAN. 

3. Fixed a problem in which the cut screen could crash when outputting to certain data 
files and either PLT or XPF files. 

4. Fixed a problem in which setting ‘Number of Passes’ in the ‘Option’ tab now correctly 
repeats cut for each shape. 

5. Fixed a problem in which the application could crash when launching Cutting Master 
5 and the ‘Cutting View’ screen simultaneously. 

6. Fixed a problem in which the cut screen failed to launch after changing the ‘Interface’ 
setting in the cutter edit screen. 

7. Fixed a problem in which changed cut settings were automatically saved even without 
performing ‘Save Cut Conditions’. 



8. Fixed a problem in which XPF files could not be selected in the save cut command 
when ‘Repeat Job’ was specified. 

9. Fixed a problem in which the email settings were hidden and difficult to view in the 
Data Link Server Settings screen. 

⚫ Modification 
1. Modified the system to display a waring message when the cut screen is closed without 

pressing the output button. 
⚫ Added 

1. Added support for macOS 26 (Tahoe). 
 
Version 1.8.87 Release date: August 20, 2025  

⚫ Fixed Bug 
1. Fixed a problem in which one side of the vertical split was not cut correctly when 

performing Tiling function on specific data. 
2. Fixed a problem in which registered Cutting Plotter information was not saved when 

installing on a new Mac OS environment. 
 
Version 1.8.67 Release date: July 1, 2025  

⚫ Function Added 

1. Added a function to save customized page size. 

 

⚫ Modification 

1. Extended the minimum value Length of Repeat CROSS CUT to 20mm in FC9000 (later 

than firmware version 2.00). 
 
⚫ Fixed Bug 

1. Fixed a problem in which a red frame appears when opening “Tiling” tab while 

registration marks are placed. 

2. Fixed a problem in which the “Thickness” and “Length” settings in the “Registration 

Marks” tab was automatically changed to their minimum values when “Millimeters” 

was selected in “Unit of Measurement”. 

3. Fixed a problem in which the printer margin was not set automatically when both 

“Use Auto Sheet Feeder (ASF)” and “Use Barcode” were checked. 

4. Fixed a problem in which Rich Black was applied instead of standard black when 

specifying black for registration marks or barcode in Adobe Illustrator. 

5. Fixed a problem in which the window frozen when opening large data with 

registration marks after using “Fit to Media” on smaller data. 

 
Version 1.7.63 Release date: March 10, 2025  

●Fixed Bug 

1. Fixed a problem in which the order/starting point/orientation of shapes in design 

data was not reflected in the cut output.  

2. Deleted unnecessary save button in “Cut Job List” of “Data Link Server”.  

3. Fixed a problem that wrong XPF files were output when more than 2 were specified 

for “Job Repetition” in the “General” tab of the cut screen. 

4. Fixed a problem that cutting was started without scanning registration marks when 



the feed direction of a segment registration mark was short and there was no 

intermediate mark. 

5. Deleted the out-of-date model. (Applicable models: FC2250 / FC4500 / CE6000) 

6. Fixed a problem that installation was forcefully terminated when an empty 

Illustrator folder was left. 

7. Fixed the problem of forced termination when starting the cut screen if there is a 

font with a name other than UTF8 in the system. 

8. Fixed a problem that Illustrator freezes when [Use Trim Mark as Registration 

Marks] is ON and [OK] button is pressed when [Align Registration Marks to 

Document Origin] is ON in the [Registration Mark] screen.  

9. Fixed a problem that unnecessary extensions (“.xml” and “.csv”) were displayed 

in the [Save As] screen of the custom line in the [Line Type] of the [Option] tab in 

the Cut screen. 

10. Fixed a problem in which cutting stopped in the middle when cutting using [Data 

Link Server]. 

 

Version 1.6.15 Release date: December 24, 2024  

●Fixed Bug 

1. Fixed an issue that slowed down the startup of the cut screen when selecting a 

part of a large data set, even if “Selection Only” was set to ON in the “Option” tab. 

2. Fixed an issue that the cut screen crashes when outputting via USB connection 

when a large amount of data that does not contain registration marks is copied 

using matrix copying. 

3. Fixed an issue that after using “Convert Rectangle” to place the registration 

marks, the registration marks were placed in the upper left corner in the next 

data. 

4. Fixed an issue when saving XPF or PLT files, the file name on the save screen is 

blank. 

5. In CE8000-40+ASF1, the wording and size of the media size “A3 Plus” have been 

corrected. 

6. Fixed an issue when “X Direction”=”Horizontal” is specified in the Registration 

Marks setting, the cut screen preview cannot be rotated. 

 
Version 1.6.6 Release date: December 2, 2024  

●Function Added 

1.  Correspondence for the CE8000-40+ASF1. 

 

●Fixed Bug 

1.  Fixed an issue when the screen is closed with “Quit” from the “File” menu,  



changes to the cut condition settings for each tab are not saved. 

2.  Fixed an issue that “Unit of Measurement” settings in “Preferences” were not 

saved when the screen was closed by “Quit” in the “File” menu. 

3.  Fixed an issue that the cutting screen crashed when “Repeat Job” was set to 

output. 

4.  Fixed an issue in which CorelDraw would freeze and could not open "Registration 

Mark" or "Send to Cutter" when using large size data with a lot of designs. 

 
Version 1.5.42 Release date: October 28, 2024  

●Function Added 

1.  Supported Adobe Illustrator 2025. 

2.  Supported macOS 15 (Sequoia) 

(Fixed an issue where the “File Format” drop-down on the “Save” screen was not 

working.) 

 

●Function Improved 

1.  Improved display of a bar indicating that data is being sent when a cut is executed. 

 

●Fixed Bug 

1.  Fixed an issue that the minimum value cannot be set for “X or Y Spacing” on the 

“Matrix Copy” tab, even if setting the color or layer that will not be cut to “OFF” in 

the “By Color”/”By Layer” option. 

2.  Fixed an issue when a cutter is changed, “Media Size” is not updated to the 

maximum value of the changed cutter. 

3.  Fixed an issue that skipping a paused color/layer ignores the next specified cut 

condition in the “By Color”/”By Layer” option. 

4.  Fixed an issue when “Optimize Cutting Order” is “None”, the outer figure is cut first, 

even if “Sort Interior Contours First” is set to “ON”. 

5.  Fixed a problem with resizing when opening the data which has registration marks 

after using “Fit to Media”. 

 
 
Version 1.4.65 Release date: August 26, 2024  

●Fixed Bug 

  1.  Fixed a problem in which “Job Size” in the “General” tab did not reflect the setting 

even if “Selection Only” was specified in the “Options” tab of the cut screen. 

2.  Fixed a problem in which scanning the first mark failed in continuous operation when  

the artboard (document) size was changed after placing the barcode.  



3.  Fixed a problem with [Barcode Link Info] being updated when reopening the  

registration mark screen without changing the design. 

4.  When using mask registration marks, the image of the mask is not reflected in the  

preview of the cut screen. 

5.  Fixed a problem that prevented adding another cutter's tab from the cut screen  

while the [Data Link Server] was open. 

 
Version 1.4.53                                    Release date: July 10, 2024  

●Added 

1. Correspondence for the CE8000. 

 

●Modification 

1.  The waiting time required from the end of cutting to the start of cutting has been 

improved. 

2.  Improved the drop-down items so that they can be selected with the up/down keys 

on the keyboard. 

 

●Function added 

1.  Added first registration mark search option. 

2.  Added Prefeed option. 

3.  Added “Data Link Server” e-mail notification. 

4.  Added firmware update notification and download update functions. 

 

●Fixed Bug 

1.  When [Step Size] is changed on the cutter, the wrong paper size is displayed when 

[Poll Size] is executed on the cut screen. 

2.   Fixed the problem that [Barcode Link Information] is changed when [Barcode 

Length] of continuous operation barcode is changed. 

3.  Fixed a problem in which [Barcode Link Information] was not updated when the 

design was changed and the registration mark screen was reopened.  

4.  Fixed a problem in which cross-cutting on the cut line occurred when the position in 

the feed direction (X direction) was changed in the [General] tab - [Position].  

5.  Fixed a problem in which cut data is not sent to the cut screen when the file name 

of design data is long. 

6.  Fixed a problem in which [Convert Rectangle] was grayed out and could not convert 

a rectangle to registration marks when an image was present, even if a rectangle was 

specified.  



7.  Fixed a problem in which [Convert Rectangle] was not grayed out when a rectangle 

(on a sublayer) that cannot be converted to registration marks was specified.  

 

8.  Fixed a problem in which another model could not be used even if the "Connect the 

cutter to output destination" was set to OFF.  

 
 
Version 1.3.138 Release date: April 15, 2024  

11. Modification 

1.  Added backup and restore functions for cutter settings.  

2.  Changed the layout of the [Help] tab of the [Remote Panel Utility] screen. 

3.   The UI of the one-point compensation option for four-point registration marks was improved.  

 

●  Fixed Bug 

1. Fixed an issue that when [Speed Priority] or [Restrict Media Movement] is specified in 

[Optimize Cutting Order], [Cut Segments From Ends to Center] will not work. 

2. Fixed an issue in which partial cuts were not made when [Speed Priority] or [Restrict Media 

Movement] is specified in [Optimize Cutting Order] and [Sort Interior Counters First] is specified. 

3. Fixed an issue that a part of the line of a shape touching the outer frame was cut off on the 

preview when using certain rounded corner data. 

4. Fixed an issue in which CM5 cut conditions were initialized when changing the layer's 

show/hide setting in Illustrator. 

 

 
Version 1.2.62 Release date: November 6, 2023  

12. Fixed Bug 

1.  Modified to allow CM5 plug-in to be installed in Illustrator 2024.  

2.  Fixed an issue that a different value is set when a value other than "millimeter" is specified  

for "Unit of measurement" and a value is entered in the text area of the [General] tab - [Job Size]. 

 
Version 1.2.55 Release date: October 17, 2023  

13. Modification 

1.  Enabled to reflect the settings from Remote Panel Utility to the cutting plotter via USB flash 

memory.  

2.  Enabled to change the registration marks position of the barcode for roll media. 

3.  [Mac] Supported macOS14. 

4.   Enabled to repeat the crosscut to do roll-to-feed operation with FC9000. 



 

●  Fixed Bug 

1.  Fixed the size of the Tiling [Relative to Media] to show the document size of the design.  

   2.  Fixed the problem that the barcode for roll media caused scanning errors under certain 

conditions.  

   3.  Fixed the problem that the registration mark settings Cutting Master 4 could not be carried 

over to Cutting Master 5.  

 
Version 1.1.20 Release date: August 23, 2023  

14. Fixed Bug 

1. Fixed an issue that the cutting result which placed out of registration marks was 

shifted when using the function “Convert rectangle”.  

2. Fixed an issue where cutlines were not centered in the preview even when “Center” 

was specified under “Alignment” in the General tab. 

 
Version 1.1.14 Release date: August 2, 2023  

15. Fixed Bug 

3. Added a ruler and a scroll bar in the preview. 

4. Fixed an issue that the one-point compensation function was not applied on the 

FC9000 series and CE7000 series 

5. Fixed an issue that added cut condition was hidden when the dropdown box was 

opened. 

6. [Mac] Fixed an issue that added the cut screen was forced to close when specific 

data was sent over a LAN connection. 

 

Version 1.0.272 Release date: June 30, 2023 

16. First release 

 

End 
 


